
 

 

           แผนการสอน/แผนการเรียนรู้ภาคทฤษฎี 

 

แผนการสอน/การเรียนรู้ภาคทฤษฎี หน่วยที่  9 

ชื่อวิชา      เทคนิคการสร้างภาพเคล่ือนไหวคอมพิวเตอร์ สอนสัปดาห์ที่  9 

ชื่อหน่วย    เข้าใจพ้ืนฐานการสร้างงานแอนิเมช่ัน 
    

คาบรวม  36 

ช่ือเรื่อง        การจัดการไทมไลน์ได้    การจัดการเลเยอร์ได้  การจัดการเฟรมได้ จ านวนคาบ 4 

หัวข้อเรื่อง 
จุดประสงค์เชิงพฤติกรรม: 
  ด้านความรู้ 

1.  การจัดการไทมไลน์ได้ 
2.  การจัดการเลเยอร์ได้ 
3.  การจัดการเฟรมได้ 

 ด้านทักษะ 
1.  ใช้ ไทมไลน์  เลเยอร์ และ เฟรม ได้ตัวชิ้นงาน 

ด้านคุณธรรม จริยธรรม/บูรณาการเศรษฐกิจพอเพียง 
1. เตรียมความพร้อมด้าน วัสดุ  อุปกรณ์สอดคล้องกับงานได้อย่างถูกต้อง 
2. ปฏิบัติงานได้อย่างถูกต้อง และส าเร็จภายในเวลาท่ีก าหนดอย่างมีเหตุและผลตามหลักปรัชญาเศรษฐกิจ

พอเพียง 
 

สาระส าคัญ 

            การสร้างภาพเคล่ือนไหวในโปรแกรม Flash จะคล้ายกับหลักการสร้างภาพยนตร์ โดยจะมีการแบ่งเนื้อหา
ท้ังหมดออกเป็นฉากย่อยๆ ท่ีเรียกว่าซีน (scene) และแต่ละซีนจะประกอบด้วยภาพนิ่งจ านวนมากท่ีเราเรียกว่า
เฟรม (frame) เมื่อน าภาพเหล่านี้มาแสดงอย่างต่อเนื่องก็จะได้เป็นภาพที่เคล่ือนไหว 

 

สมรรถนะอาชีพประจ าหน่วย  
1. ออกแบบช้ินงานโดยใช้ไทมไลน์  เลเยอร์ และ เฟรม ได้ตัวชิ้นงาน 

 
 
 
 



 

 

 
จุดประสงค์ท่ัวไป / บูรณาการเศรษฐกิจพอเพียง      

1.  มีความรู้ความเข้าใจและสามารถจัดการไทมไลน์ได้ 
            2. มีความรู้ความเข้าใจและสามารถจัดการเลเยอร์ได้ 
            3. มีความรู้ความเข้าใจและสามารถจัดการเฟรมได้ 

จุดประสงค์เชิงพฤติกรรม / บูรณาการเศรษฐกิจพอเพียง 
1.  ใช้ ไทมไลน์  เลเยอร์ และ เฟรม มาประตัวชิ้นงานได้ 
2. เตรียมความพร้อมด้าน วัสดุ  อุปกรณ์สอดคล้องกับงานได้อย่างถูกต้อง 
3. ปฏิบัติงานได้อย่างถูกต้อง และส าเร็จภายในเวลาท่ีก าหนดอย่างมีเหตุและผลตามหลักปรัชญา

เศรษฐกิจพอเพียง    
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

 

เนื้อหาสาระ 
 

เร่ืองของ Frame 

 

• ไทมไลน์หรือเส้นเวลา จะใช้ในสร้างและก าหนดรายละเอียดของการเคล่ือนไหว โดยเอาองค์ประกอบ ท่ีจะ
เคล่ือนไหว มาจัดวางต่อกันละภาพในแต่ละช่วงเวลา ท่ีเรียกว่าเฟรม (Frame) โดยเราจะก าหนด เส้นเวลาให้เล่น
ภาพเคล่ือนไหวซ้ าๆ หรือเล่นแล้วหยุดก็ได้ 

 

• ไทมไลน์แบ่งออกเป็น 2 ส่วนใหญ่ๆ ได้แก่  
ส่วนเลเยอร์ (Layer) ซึ่งแต่ละเลเยอร์เปรียบเหมือนแผนใสท่ีสามารถวางภาพหรือออบเจ็กต์ได้ โดยแต่ละเลเยอร์
นั้นแยกเป็นอิสระต่อกัน แต่ประกอบกันเป็นชันงานเดียว  
ส่วนเฟรม (Frame) ท่ีแสดงช่องเฟรมต่างๆ ซึ่งท างานเหมือนกับเฟรมท่ีประกอบกันเป็นภาพยนตร ์โดยเมื่อมีการ
น าเฟรมเหล่านี้มาแสดงอย่างต่อเนื่องก็จะท าให้เกิดภาพเคล่ือนไหว ท้ังนี้ Frame จะแสดงผลอ ทีละเฟรม โดยจะมี
หัวอ่าน (Playhead) ท่ีเป็นส้นสีแดงคอยบอกต าแหน่งว่าก าลัง ท างานอยู่ท่ีเฟรมใด เมื่อเราคลิกขวาท่ีเฟรมใดๆ จะมี
หน้าต่างขึ้นมาดังภาพ ซึ่งเราจะสามารถก าหนด การเพิ่ม ลด ปรับเปล่ียน แก้ไข เรื่องท่ีเกี่ยวกับเฟรมได้ท่ีนี่ 



 

 

 

• เฟรมนั้นสามารถท่ีจะแบ่งออกได้ 3 อย่างคือ 
1. Frame คือเฟรมช่วงเวลาเปล่าๆ ท่ีไม่สามารถบรรจุวัตถุลงไปได้ ท่ีถ้าเป็นสีขวาก็จะไม่มีอะไรอยู่ ในช่วงเวลานั้น
เลย แต่หากเป็นสีเทา คือได้แสดงวัตถุท่ีมาจาก Keyframe ด้านหน้าหรือท่ีมาก่อน 
2. Keyframe คือ เฟรมท่ีมีวัตถุอยู่ในนั้น (มีจุดสีด า) 
3. Blank Keyframe คือเฟรมเปล่าๆ ท่ีสามารถบรรจุวัตถุลงไปได้ (มีวงกลมสีขาว) 

 

• การแสดงสถานะบน Time Line 
1. Current frame (วงกลมแดงซ้าย)  เป็นช่องท่ีบอกว่าขณะนี้ Playhead แสดง Frame อยู่ท่ีช่องเท่าไหร่  
2. Frame Rate (วงกลมแดงกลาง)   เป็นช่องท่ีบอกว่าขณะนี้ Playhead วิ่งด้วยความเร็วกี่ Frame ต่อวินาที  
3. Elapsed time  (วงกลมแดงขวา) เป็นช่องทีบอกว่าเมื่อ Playhead วิ่งมาถึง Frame นี้จะใช้เวลาเท่าไหร่ 



 

 

 

• คัีย์ลัดเกี่ยวกับเฟรม  
1. F5 = สร้าง Frame  
2. F6 = สร้าง Keyframe  
3. F7 = สร้าง Blank Keyframe 
 
Timeline คือ ส่วนท่ีจะใช้ควบคุมการเคล่ือนไหวของอนิเมช่ัน โดยจะแยกส่วนของการใช้งานหลักๆออกเป็น 2 
ส่วนนะค่ะ คือ Layer(เลยอร์)  และ Frame(เฟรม) ในบทความนี้เราจะมาท าความเข้าใจถึงการใช้งานในส่วน
ของเลเยอร์กันก่อนนะค่ะ 
เลเยอร์จะอยู่ท่ีบริเวณส่วนล่างสุดของโปรแกรม เราสามารถเพิ่มจ านวนช้ันของเลเยอร์ได้เรื่อยๆตามความ
ต้องการค่ะ  
การเพิ่มเลเยอร์ใหม่  
ให้คลิกท่ีปุ่มไอคอน "New > Layer" หรือไปท่ีค าส่ัง Insert > Timeline > Layer  
การเปลี่ยนชื่อเลเยอร์ และ โฟลเดอร์ 
ให้ดับเบิ้ลคลิกท่ีช่ือของเลเยอร์ท่ีต้องการ จากนั้นท่ีช่ือของเลเยอร์จะกลายเป็นช่อง ส าหรับให้เราพิมพ์ชื่อใหม่ท่ี
ต้องการลงไปค่ะ 
 
 
การเลือกเลเยอร์มากกว่าหนึ่ง 
มี 2 วิธีด้วยกันนะค่ะ ในกรณีท่ีเราต้องการเลือกเลเยอร์หลายๆอันท่ีติดกัน ก็ให้คลิกท่ีเลเยอร์ "บน" ท่ีเรา
ต้องการเลือกก่อน จากนั้นให้กดปุ่ม "Shift" ค้างไว้ แล้วคลิกท่ีเลเยอร์ "ล่าง" สุดท่ีเราต้องการเลือก 
 
ส่วนอีกวิธี จะใช้ในกรณีท่ีเราต้องการเลือกเฉพาะบางเลเยอร์ท่ีไม่ได้อยู่ติดๆกัน คือให้กดปุ่ม "Ctrl" ค้างไว้ และ
คลิกเลือกเลเยอร์อื่นๆท่ีต้องการค่ะ 
 
การย้ายล าดับชั้นของเลเยอร์ 
ให้คลิกท่ีเลเยอร์ท่ีต้องการย้ายล าดับค้างไว้ แล้วลากไปวางไว้ระหว่างเลเยอร์อื่นๆท่ีต้องการสลับต าแหน่ง 
การลบเลเยอร์  
ให้คลิกท่ีปุ่มไอคอนรูปถังขยะ "Delete"  คลิกขวาบนเลเยอร์ท่ีต้องการลบ แล้วเลือกค าส่ัง "Delete Layers" 
 
สถานะของแต่ละเลเยอร์ 
ทุกเลเยอร์จะมีสถานะอยู่ 3 สถานะให้เลือกใช้งานตามความเหมาะสม ซึ่งจะช่วยให้การท างานง่ายและรวดเร็ว



 

 

ขึ้นค่ะ นั่นคือ... 
 
1. การซ่อนและแสดงเลเยอร์ 
หากมีหลายช้ินงานวางซ้อนกันในแต่ละเลเยอร์ บางครั้งเราจ าเป็นต้องซ่อนภาพบางช้ินไว้ เพื่อให้มองเห็นภาพ
ช้ินอื่นๆท่ีวางอยู่เลเยอร์ด้านหลังวิธีซ่อนเลเยอร์ ก็คลิกท่ี  ในต าแหน่งดังภาพด้านล่าง จากนั้นเครื่องหมายใน
ภาพจะเปล่ียนไปกลายเป็น  นั่นคือเลเยอร์นั่นถูกซ่อนเรียบร้อยแล้ว ถ้าเราต้องกรยกเลิกการซ่อนก็ให้คลิกท่ีปุ่ม
เดิมซ้ าอีกครั้ง 
2. การล๊อคเลเยอร์ 
ถ้าบางเลเยอร์เราไม่ต้องการให้มีการแก้ไขใดๆอีก เพื่อความไม่พล้ังเผลอไปคลิกจับช้ินงานใดเคล่ือย้ายเข้า เรา
จ าเป็นต้องล๊อคมันไว้ให้อยู่กับท่ี และไม่ให้แก้ไขได้อีก  
 
ให้คลิกท่ี  ในต าแหน่งดังภาพข้างล่าง จากนั้นเครื่องหมายของภาพจะเปลียนเป็น นั่นหมายความว่าเราจะไม่
สามารถแก้ไขใดๆในเลเยอร์นั้นได้ หากต้องการยกเลิกก็ให้คลิกซ้ าอีกครั้งเพื่อปลดล๊อคออกค่ะ 
 
3. การซ่อนพื้นหลัง 
การปิดพื้นหลังบางเลเยอร์ หรือทุกเลเยอร์ไว้ จะท าให้เราเห็นภาพท่ีเลเยอร์นั้นๆ เป็นเส้นโครง ซึ่งจะท าให้ง่าย
ต่อการแก้ไข และจับเคล่ือนย้ายไปวางในต าแหน่งท่ีต้องการได้ถูกต้อง 
 
ให้คลิกท่ี "ช่องสี" ส่ีเหล่ียมซึ่งเป็นสีทึบ (ดูภาพข้างล่าง) จากนั้นเครื่องหมายของภาพจะแสดงให้เห็นเป็น "เส้น
ขอบ" ซึ่งหมายความว่า เลเยอร์นั้นๆก าลังแสดงให้เห็นเฉพาะเส้นโครง หากต้องการยกเลิกก็ให้คลิกซ้ าบน
ต าแหน่งเดิมอีกครั้ง 
การสร้างโฟลเดอร์ใหม่ 
ในกรณีท่ีช้ินงานของเรามีมากกว่า 10-20 เลเยอร์ขึ้นไป โฟลเดอร์จะถูกน ามาใช้เพื่อรวมกลุ่มช้ินงานของเราให้
อยู่ในหมวดหมู่เป็นระเบียบ ท าให้เราค้นหาช้ินงานท่ีต้องการแก้ไขง่ายกว่าการมาคลิกหาทีละตัว 
 
การสร้างโฟลเดอร์ใหม่ - ให้คลิกท่ีปุ่ม "New Foloder" หรือไปท่ีค าส่ัง Insert > Timeline > Layer 
Foloder  
การย้ายชิ้นงานเข้าไปอยูใ่นโฟลเดอร์ 
ให้คลิกเลือกเลเยอร์ท่ีต้องการจัดให้เป็นหมวดหมู่ แล้วลากไปปล่อยบนโฟลเดอร์ท่ีต้องการ  
การเปิด-ปิดเลเยอร์ 
ให้คลิกท่ีปุ่มลูกศร (ดูภาพด้านล่างประกอบ) เพื่อเปิด-ปิดเลเยอร์  
การดึงชิ้นงานที่ไม่ต้องการออกจากโฟลเดอร์ 
ให้คลิกเลือกเลเยอร์ท่ีต้องการน าออกค้างไว้ แล้วลากไปปล่อยไว้นอกโฟลเดอร์ 
การลบโฟลเดอร์ 



 

 

การลบโฟลเดอร์นั้น มันจะลบงานทุกช้ินของเราท่ีอยู่ภายในออกไปด้วยทั้งหมด ก่อนท่ีเราจะลบโฟลเดอร์ เรา
ควรแน่ใจก่อนว่า ภายในโฟลเดอร์นั้นๆไม่มีวัตถุหรือภาพช้ินใดตกค้างอยู่ (ในกรณีท่ีมีช้ินงานตกค้างอยู่ใน
โฟลเดอร์นั้นๆ ตามปกติโปรแกรมจะท าการเตือนก่อน) 
การลบโฟลเดอร์ - จะเหมือนกับการลบเลเยอร์ค่ะ คือ ให้คลิกท่ีปุ่ม "Delete"  คลิกขวาบนเลเยอร์ท่ีต้องการลบ 
แล้วเลือกค าส่ัง "Delete Layers" 
 

 
***เราสามารถสร้างโฟลเดอร์หลายๆตัวซ้อนกัน เพื่อให้งานของเราแบ่งกลุ่มเป็นระเบียบได้มากขึ้นนะค่ะ  
การก าหนดการแสดงมุมมองของ Timeline 
ให้คลิกท่ีปุ่มเมนูค าส่ังย่อยท่ีมุมขวาบนของ Timeline แล้วเลือกมุมมองท่ีเราต้องการ  
*ในกรณีท่ีงานของเรามีจ านวนมากๆ ควรเลือกเป็น "Short" เพราะจะท าให้ความกว้างของแต่ละเลเยอร์แคบลง 
มองเห็นเลเยอร์ท่ีแสดงอยู่ได้มากขึ้น 
ผลลัพธ์จากการเลือกมุมมองแบบ "Short" 
*แต่ถ้าช้ินงานของเราแต่ละโฟลเดอร์/เลเยอร์ มีเฟรมไม่มาก ก็สามารถเลือกแบบ "Preview" ได้ เพราะจะ
แสดงภาพชิ้นงานแต่ละเลเยอร์ให้เห็นค่ะ 
การเพิ่มความยาวให้กับเลเยอร์  
บางครั้งช่ือท่ีเราต้ังให้กับเลเยอร์ก็ยาวเกินไป หรือมีโฟลเดอร์ซ้อนกันหลายช้ันท าให้ไม่สามารถอ่านช่ือแต่ละเล
เยอร์ได้สะดวก เพราะเนื้อที่ความยาวของแต่ละเลเยอร์น้อยเกินไป  
เราสามารถเพิ่มความยาวของเลเยอร์ให้มากขึ้น โดยให้คลิกท่ีเส้นระหว่างกลางค้างไว้ และปรับเล่ือนขนาดตาม
ความต้องการ 
 
 

 
การปรับแต่งคุณสมบัติของเลเยอร์  
เราสามารถปรับแต่งคุณสมบัติของแต่ละเลเยอร์ได้ โดยให้ดับเบิ้ลคลิกท่ีไอคอนรูปส่ีเหล่ียมท่ีอยู่หน้าช่ือเลเยอร์ท่ี
ต้องการ (ดูภาพล่างประกอบ)  
 
หรืออีกวิธีใก้คลิกเลือกเลเยอร์ท่ีต้องการ และไปท่ีค าส่ัง Modify > Timeline > Layer Properties  
 

 
ความหมายของคุณสมบัติต่างๆ มีดังนี้ค่ะ 



 

 

*Name - ใช้ต้ังช่ือให้กับเลเยอร์นั้นๆ 
  -- Show - ก าหนดให้แสดงเลเยอร์(หากถูกซ่อนอยู่) 
  -- Lock  - ก าหนดให้ท าการล๊อคเลเยอร์นั้นไว้ (เพื่อกันการถูกแก้ไข) 
 
*Type  - ใช้ก าหนดประเภทของเลเยอร์ 
-- Normal  ท าให้เป็นเลเยอร์แบบปกติ 
-- Guide  ท าให้เป็นเลเยอร์ไกด์ (เกี่ยวกับการควบคุมอนิเมช่ัน) 
-- Guided ท าให้เป็นเลเยอร์ท่ีจะท างานร่วมกับเลเยอร์ไกด์  
-- Mask ท าใเป็นกลายเป็นเลเยอร์ Mask (เลเยอร์บัง) 
-- Masked  ท าให้กลายเป็นเลเยอร์ท่ีจะท างานร่วมกับเลเยอร์ Mask 
--Foloder เปล่ียนเลเยอร์นั้นๆ ให้เป็น โฟลเดอร์ 
 
*Outline Color - ก าหนดสีให้กับเส้นโครงร่าง 
*View layer as outlines - แสดงวัตถุหรือภาพที่เลเยอร์นั้นให้เป็นเส้นโครงร่าง 
*Layer height - ใช้ก าหนดความสูงให้กับเลเยอร์ท่ีเลือก 
 
 
 
 
 
 
 
 
 
 

 

กิจกรรมการเรียนการสอนหรือการเรียนรู้ 
ข้ันตอนการสอนหรือกิจกรรมของครู ข้ันตอนการเรียนรู้หรือกิจกรรมของนักเรยีน 

1.  ข้ันน าเข้าสู่บทเรียน  (15 นาท ี) 
1. บอกวัตถุประสงค์การเรียน  
2. กฏเกณฑ์การเรียน คะแนน วิธีการวัดผล 
3. สอบเก็บคะแนนบทท่ี 8 
4. น าเข้าสู่บทเรียน 

  

1.  ข้ันน าเข้าสู่บทเรียน  (15 นาท ี) 
      1. ฟังวัตถุประสงค์การเรียน  
      2.  ฟังกฏระเบียบในการเรียน 
      3.  สอบปฏิบัติกับเครื่องคอมพิวเตอร์ 
      4.  ฟังและตอบค าถาม 
 



 

 

2.  ขั้นให้ความรู้ (75 นาท)ี 
1. สอนวิธีการใช้ไทมไลน์   เลเยอร์ จัดการเฟรม 
2. ครูให้เรียนจาก CAI  
3. ลองปฏิบัติตามจาก CAI  
4. ท าการสรุปส่วนประกอบ เครื่องมือ ร่วมกัน

ในช้ันเรียนโดยการถาม-ตอบ 
 

3. ขั้นประยุกต์ใช้ ( 105 นาที ) 

1. ผู้สอนให้ผู้เรียนท าแบบฝึกหัด   

2.  น าส่ิงท่ีเรียนไปใช้ในการประกอบช้ินงาน 
 

4.  ขั้นสรุปและประเมินผล ( 30 นาที ) 
1. ผู้สอนและผู้เรียนร่วมกันสรุปเนื้อหาท่ีได้

เรียนให้มีความเข้าใจในทิศทางเดียวกัน 
2. สอบเก็บคะแนน 

 
 

 
 
 

2.  ข้ันให้ความรู้ (75 นาท ี) 
1. สอนวิธีการใช้ไทมไลน์   เลเยอร์ จัดการเฟรม 
2. ดูวิธีการเรียนจาก CAI  
3. ลองปฏิบัติตามจาก CAI  
4. ท าการสรุปส่วนประกอบ เครื่องมือ ร่วมกันใน

ช้ันเรียนโดยการถาม-ตอบ 
 
3.  ขั้นประยุกต์ใช้ ( 105 นาท ี) 

1. ผู้เรียนท าแบบฝึกหัด    
2. น าส่ิงท่ีเรียนไปท าการสร้างช้ินงาน 

 
4.  ข้ันสรุปและประเมินผล ( 30 นาที ) 

1. ผู้สอนและผู้เรียนร่วมกันสรุปเนื้อหาท่ีได้เรียน
เพื่อให้มีความเข้าใจในทิศทางเดียวกัน 

2. ลองฝึกทักษะเพื่อน ามาสอบปฏิบัติ 
 
 
 
 
 
 
 
 
 
 
 

 

งานที่มอบหมายหรือกิจกรรมการวัดผลและประเมินผล 

         ก่อนเรียน  
             1.   การถาม-ตอบ ก่อนเรียน    
 

         ขณะเรียน 
   สืบค้นข้อมูลจาก Internet เพื่อเป็นเนื้อหาเพิ่มเติมขณะเรียน 
 



 

 

 หลังเรียน 
1.  ช้ินงานนักศึกษาท่ีครูให้ค้นหา 
2. อ่านหนังสือสอบในสัปดาห์ถัดไป 
 

ค าถาม 
          - 

ผลงาน/ชิ้นงาน/ความส าเร็จของผู้เรียน 
1.  งานท่ีปฏิบัติกับเครื่องคอมพิวเตอร์ 

 

สมรรถนะที่พึงประสงค ์
ผู้เรียนสร้างความเข้าใจเกี่ยวกับ    
1. วิเคราะห์และตีความหมาย 
2. ต้ังค าถาม 
3. อภิปรายแสดงความคิดเห็นระดมสมอง 
4. การประยุกต์ความรู้สู่งานอาชีพ 

 

สมรรถนะการสร้างคา่นิยม 
ปลูกฝังคุณธรรม จริยธรรม 
 
 
 
 
 
 
 
 
 

 

สมรรถนะการปฏิบตัิงานอาชีพ 

1.     ใช้ในการประกอบวิชาชีพด้านการออกแบบ    
 

สมรรถนะการขยายผล 
- 



 

 

สื่อการเรียนการสอน/การเรยีนรู ้
 
 สื่อสิ่งพิมพ์ 
                ตัวอย่าง งานต่าง ๆ ใน Internet  
  

 
 

 
 สื่อโสตทัศน์ (ถ้ามี) 

1. CAI 
 
    
สื่อของจริง 
 

1.    ส่ือนักศึกษาท่ีครูให้ท าในภาคเรียนท่ีแล้ว , Internet, E-learning, E- books, Website 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

แหล่งการเรียนรู ้
 
     ในสถานศึกษา 



 

 

1. ห้องสมุดวิทยาลัยเทคนิคพัทยา 
2. ห้องปฏิบัติการ  732 
3. มือถือนักศึกษา  (กรณี Net วิทยาลัยไม่สามารถใช้งานได้) 
 

    นอกสถานศึกษา 

                           - 
 

การบูรณาการ/ความสมัพันธ์กับวิชาอ่ืน 
1. บูรณาการกับวิชาชีวิตและวัฒนธรรมไทย   ด้านการพูด  การอ่าน  การเขียน และการฝึกปฏิบัติตนทาง

สังคมด้านการเตรียมความพร้อม  ความรับผิดชอบ และความสนใจใฝ่รู้ 
2. บูรณาการกับวิชากีฬาเพื่อพัฒนาสุขภาพและบุคลิกภาพ  ด้านบุคลิกภาพในการน าเสนอหน้าช้ันเรียน 
3. บูรณาการกับวิชาหลักเศรษฐศาสตร์ ด้านการเลือกใช้ทรัพยากรอย่างประหยัด 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

การประเมินผลการเรียนรู ้



 

 

 หลักการประเมินผลการเรียนรู ้
 

 ก่อนเรียน 
1.  สืบค้นตัวอย่างประกอบ 

 
 
            ขณะเรียน 

1. ความสนใจในการเรียนรู้ การค้นคว้า การมีส่วนร่วมในกิจกรรม 
2. การซักถามและการตอบค าถาม 

     
 
            หลังเรียน 

     สอบหลังเรียน 

 
ผลงาน/ชิ้นงาน/ผลส าเร็จของผู้เรียน  

1.   ช้ินงานท่ีมอบหมายให้นักศึกษาปฏิบัติกับเครื่องคอมพิวเตอร์  
 
รายละเอียดการประเมินผลการเรียนรู้ 

1.  สอบปฏิบัติกับคอมพิวเตอร์ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

แบบประเมินผลการน าเสนอผลงาน 

ช่ือกลุ่ม……………………………………………ช้ัน………………………ห้อง........................... 
รายช่ือสมาชิก       1……………………………………เลขท่ี…….    2…………………………………เลขท่ี……. 

                        3……………………………………เลขท่ี…….    4……………………………………เลขท่ี……. 

ท่ี รายการประเมิน 
คะแนน 

ข้อคิดเห็น 
3 2 1 

1 เนื้อหาสาระครอบคลุมชัดเจน (ความรู้เกี่ยวกับเนื้อหา ความ
ถูกต้อง  ปฏิภาณในการตอบ และการแก้ไขปัญหาเฉพาะหน้า) 

    

2 รูปแบบการน าเสนอ     
3 การมีส่วนร่วมของสมาชิกในกลุ่ม     
4 บุคลิกลักษณะ  กิริยา  ท่าทางในการพูด  น้ าเสียง  ซึ่งท าให้

ผู้ฟังมีความสนใจ 
    

รวม     
 

            ผู้ประเมิน………………………………………………… 
เกณฑ์การให้คะแนน 
1.  เนื้อหาสาระครอบคลุมชัดเจนถูกต้อง 
 3  คะแนน    =  มีสาระส าคัญครบถ้วนถูกต้อง  ตรงตามจุดประสงค์ 
 2  คะแนน    =  สาระส าคัญไม่ครบถ้วน  แต่ตรงตามจุดประสงค์ 
 1  คะแนน    =  สาระส าคัญไม่ถูกต้อง ไม่ตรงตามจุดประสงค์ 
2.  รูปแบบการน าเสนอ 

3  คะแนน     =  มีรูปแบบการน าเสนอท่ีเหมาะสม  มีการใช้เทคนิคท่ีแปลกใหม่  ใช้ส่ือและ
เทคโนโลยีประกอบการ น าเสนอท่ีน่าสนใจ  น าวัสดุในท้องถิ่นมาประยุกต์ใช้อย่างคุ้มค่าและ
ประหยัด 

1. คะแนน    =  มีเทคนิคการน าเสนอท่ีแปลกใหม่  ใช้ส่ือและเทคโนโลยีประกอบการน าเสนอท่ี
น่าสน ใจ  แต่ขาดการประยุกต์ใช้ วัสดุในท้องถิ่น         

           1  คะแนน     =  เทคนิคการน าเสนอไม่เหมาะสม และไม่น่าสนใจ 
3.  การมีส่วนร่วมของสมาชิกในกลุ่ม 
 3  คะแนน     =  สมาชิกทุกคนมีบทบาทและมีส่วนร่วมกิจกรรมกลุ่ม 
 2  คะแนน     =  สมาชิกส่วนใหญ่มีบทบาทและมีส่วนร่วมกิจกรรมกลุ่ม 
 1  คะแนน     =  สมาชิกส่วนน้อยมีบทบาทและมีส่วนร่วมกิจกรรมกลุ่ม 
4.  ความสนใจของผู้ฟัง 
 3  คะแนน     =  ผู้ฟังมากกว่าร้อยละ 90  สนใจ และให้ความร่วมมือ 



 

 

 2  คะแนน     =  ผู้ฟังร้อยละ 70-90  สนใจ และให้ความร่วมมือ 
 1  คะแนน     =  ผู้ฟังน้อยกว่าร้อยละ 70  สนใจ และให้ความร่วมมือ 

แบบประเมนิกระบวนการท างานกลุ่ม 

ช่ือกลุ่ม……………………………………………ช้ัน………………………ห้อง........................... 
รายช่ือสมาชิก       1……………………………………เลขท่ี…….    2…………………………………เลขท่ี……. 

                        3……………………………………เลขท่ี…….    4……………………………………เลขท่ี……. 

ท่ี รายการประเมนิ 
คะแนน 

ข้อคิดเห็น 
3 2 1 

1 การก าหนดเป้าหมายร่วมกัน     
2 การแบ่งหน้าท่ีรับผิดชอบและการเตรียมความ

พร้อม 
    

3 การปฏิบัติหน้าท่ีท่ีได้รับมอบหมาย     
4 การประเมินผลและปรับปรุงงาน     

รวม     
 

ผู้ประเมิน………………………………………………… 
วันท่ี…………เดือน……………………..พ.ศ…………... 

เกณฑ์การให้คะแนน 

1.  การก าหนดเป้าหมายร่วมกัน 
 3  คะแนน  =  สมาชิกทุกคนมีส่วนร่วมในการก าหนดเป้าหมายการท างานอย่างชัดเจน 
 2  คะแนน  =  สมาชิกส่วนใหญ่มีส่วนร่วมในการก าหนดเป้าหมายในการท างาน 

1  คะแนน  =  สมาชิกส่วนน้อยมีส่วนร่วมในการก าหนดเป้าหมายในการท างาน 
2.  การมอบหมายหน้าท่ีรับผิดชอบและการเตรียมความพร้อม 

3  คะแนน  =  กระจายงานได้ท่ัวถึง  และตรงตามความสามารถของสมาชิกทุกคน   มีการ
จัดเตรียมสถานท่ี  ส่ือ /  
                     อุปกรณ์ไว้อย่างพร้อมเพรียง 

 2  คะแนน  =  กระจายงานได้ท่ัวถึง  แต่ไม่ตรงตามความสามารถ  และมีส่ือ / อุปกรณ์ไว้อย่าง
พร้อมเพรียง แต่ขาด 
                                     การจัดเตรียมสถานท่ี 
 1  คะแนน  =  กระจายงานไม่ท่ัวถึงและมีส่ือ / อุปกรณ์ไม่เพียงพอ 
3.  การปฏิบัติหน้าท่ีท่ีได้รับมอบหมาย 
 3  คะแนน  =  ท างานได้ส าเร็จตามเป้าหมาย และตามเวลาท่ีก าหนด 
 2  คะแนน  =  ท างานได้ส าเร็จตามเป้าหมาย แต่ช้ากว่าเวลาท่ีก าหนด 



 

 

 1  คะแนน  =  ท างานไม่ส าเร็จตามเป้าหมาย 
4.  การประเมินผลและปรับปรุงงาน 
 3  คะแนน  =  สมาชิกทุกคนร่วมปรึกษาหารือ  ติดตาม  ตรวจสอบ  และปรับปรุงงานเป็นระยะ 
 

บันทึกหลังการจัดการเรียนรู้ 

รหัสวิชา  3204-2102  เทคนิคการสร้างภาพเคลื่อนไหวคอมพิวเตอร์   
วันที่ …………………….. สัปดาห์ที่…...... 

.คอมพิวเตอร์ธุรกิจ คอมพิวเตอร์ธุรกิจ/2 | ปวส.1 | 2558  
ครูผู้สอน 2003002 นางสาวภคมน หวังวัฒนากูล จ านวน 20 คน  

 
หัวข้อเร่ือง/เนื้อหาสาระ : 

 
  

 
กิจกรรม/วิธีการสอน 

 
  

 
  

 
 
สื่อการเรียนรู้/แหล่งการเรียนรู้ 

 
 
 
สอดแทรกคุณธรรมจริยธรรม  

 
  

 
 

 
การวัดและประเมินผลหลังการสอน  

 
  

 
 

 
สมรรถนะท่ีนักเรียนได้  

 
  

 
 

 
ผลการใช้และปรับปรุงแผนการสอน  

 
  

 
 

  

ปัญหาที่น าไปสู่การวิจัย  
 
 



 

 

  

 

 
 
 

แบบประเมินผล 
วันที่ .............. เดือน ............................... พ.ศ. ............... 

ล าดับ
ที่ ชื่อ - นามสกุล 

ผลการประเมิน 

รวม ผลงาน การมีส่วน
ร่วม 

ความรับผิดชอบ 

  1 2 3 4 1 2 3 1 2 3 10 

             

             

             

             

             

             

             

             

             

             

             

             

             

             

             

             

 

แบบประเมินคุณธรรมจรยิธรรม 

ค าชี้แจง  ให้ขดีเครื่องหมายถูก ในช่องพฤติกรรมของนักเรียนเพ่ือประเมินคุณธรรม
จริยธรรม 

เกณฑ์การตัดสิน 
                                           4          คะแนน          หมายถึง          พฤติกรรมดีมาก 

                                       3          คะแนน          หมายถึง          พฤติกรรมดี 
                                       2          คะแนน          หมายถึง          พฤติกรรมพอใช้ 
                                       1          คะแนน          หมายถึง          พฤติกรรมต้องปรับปรุง 



 

 

             

             

เกณฑ์การให้คะแนน 
 ดีมาก = 4            ดี = 3  ปานกลาง = 2   ต้องปรับปรุง = 1 
 
 
 

 
 

เลข 

ที ่

 

ชื่อ – สกุล 

ผู้รับการ 

ประเมิน 

 

                             พฤติกรรมของนักเรียน 

ความมีวินัย ความ
รับผิดชอบ 

มนุษย์
สัมพันธ์ 

ความอดทน ความรอบ
ปลอดภัย 

 

รวม 

4 3 2 1 4 3 2 1 4 3 2 1 4 3 2 1 4 3 2 1 20 

1                       

2                       

3                       

4                       

5                       

6                       

7                       

8                       

9                       

10                       

11                       

12                       

13                       

14                       

15                       

16                       

17                       

18                       

19                       

20                       

21                       

22                       

23                       

24                       

25                       

26                       

27                       

28                       



 

 

29                       

30                       

 

                                                                                      ผู้ประเมิน……………………………                                                                                                                            

                                                                                                 (…………………………..) 
 

 
 

อธิบาย (หมายถึง การให้รายละเอียดเพิ่มเติม ขยายความ ถ้ามีตัวอย่างให้ยกตัวอย่าง  ประกอบ) ตอบ
แบบสั้น 

1. ไทม์ไลน์คืออะไร จงอธิบายมาพอเข้าใจ 
ตอบ คือ  เป็นเครื่องมือที่ใช้ในการสร้างและควบคุมการเล่นของภาพเคล่ือนไหว  ประกอบด้วย  2  
ส่วนหลัก  คือ  เลเยอร์ (Layer)  และเฟรม (Frame)  เลเยอร์นั้นเปรียบเสมือนเป็นแผ่นใสท่ีใช้จัดวาง
ออบเจ็กต์หลาย ๆ ช้ันให้เรียงซ้อนกันได้  โดยท่ีแต่ละออบเจ็กต์มีความเป็นอิสระต่อกัน  ส่วนเฟรม
เปรียบเทียบได้กับช่องท่ีใช้บรรจุเนื้อหาเพื่อแบ่งภาพเคล่ือนไหวออกเป็นขั้นตอนย่อย ๆ เหมือนกับเป็น
ภาพนิ่งหรือฟิล์มภาพยนตร์แต่ละภาพ  ซึ่งเมื่อน าหลาย ๆ เฟรมมาแสดงอย่างต่อเนื่อง  จะท าให้เห็นเป็น
ภาพเคล่ือนไหวท่ีสมบูรณ์ 
2. ไทม์ไลน์ประกอบด้วยส่วนใดบ้าง แต่ละส่วนมีหน้าท่ีอย่างไร 
ตอบ ประกอบด้วยเลเยอร์ และเฟรม 
3. เลเยอร์คืออะไร อธิบายมาพอเข้าใจ 
ตอบ เลเยอร์  เปรียบเสมือนแผ่นใส 1 แผ่น  ท่ีวางอยู่บนเครื่องฉาย Overhead หากน าแผ่นใส 2 แผ่น
มาวางซ้อนทับกัน  ก็จะเปรียบได้กับเลเยอร์ 2 เลเยอร์ท่ีถูกสร้างขึ้นมาในโปรแกรม Flash 8 (CS3)  ซึ่งใน
โปรแกรมสามารถแยกช้ินส่วนท่ีเป็นส่วนประกอบต่าง ๆ ของการสร้างภาพเคล่ือนไหวออกเป็นหลาย ๆ เล
เยอร์ได้ 
4. เฟรมคืออะไร และมีหน้าท่ีอย่างไร 
ตอบ เฟรม  ท าหน้าท่ีในการแจกแจงรายละเอียดความเคล่ือนไหวต่าง  ๆ ของช้ินงานท่ีปรากฏบน 
Stage ซึ่งส่ิงท่ีเราเห็นว่าเกิดขึ้นกับช้ินงานต่าง ๆ ในขณะนั้นจะเป็นลักษณะเฉพาะของแต่ละ  เฟรม (ณ 
ต าแหน่งท่ีหัวอ่าน (Play Head) ช้ีอยู่)  ซึ่งจะเหมือนหรือแตกต่างกันไปก็ได้ 
5. เฟรมมีท้ังหมดกี่ชนิด อะไรบ้าง 
ตอบ 2 ชนิด  ได้แก่ คีย์เฟรม (Keyframe) และเฟรมระหว่างกลาง (In-Between Frame) 
6. fps คืออะไร และให้อธิบายว่า 12fps หมายความว่าอะไร 
ตอบ fps คือ Frame Per Second ความเร็วในการแสดงภาพเคล่ือนไหว  
 12 fps คือ ในเวลา 1 วินาที สามารถแสดงภาพเคล่ือนไหวได้จ านวน 12 เฟรมแบบต่อเนื่อง 
7. การสร้างคีย์เฟรมใหม่ท าได้กี่วิธี อะไรบ้าง 



 

 

ตอบ การสร้างคีย์เฟรมท าได้ 3 วิธี 
 วิธีที่ 1  กดคีย์ F6 
 วิธีท่ี 2  เลือกค าส่ัง Insert > Timeline > Keyframe 
 วิธีท่ี 3  คลิกเฟรมท่ีต้องการแล้วคิกค าส่ัง Insert Keyframe 
8. การก๊อปป้ีเฟรมนิยมใช้ในงานประเภทใด 
ตอบ การสร้างภาพเคล่ือนไหว 
9. การแสดงเฟรมแบบประหยัดมีวิธีการอย่างไรบ้าง อธิบายพอเข้าใจ 

ตอบ 1.  คลิกปุ่ม   
 2.  คลิกท่ี Tiny 
 3.  โปรแกรมจะแสดงเฟรมแบบประหยัดพื้นท่ีตามต้องการ 
 
ตอนที่  2  : อธิบายค าศัพท์ (หมายถึง แปลค าศัพท์ ให้รายละเอียดเพิ่มเติม ขยายความ ถ้ามี     

ตัวอย่างให้ยกตัวอย่างประกอบ) ตอบแบบสั้น 
1. TimeLine 
ตอบ ไทม์ไลน์ 
2. Layer 
ตอบ เลเยอร์ 
3. Frame Number 
ตอบ หมายเลขเฟรม 
4. Play Head 
ตอบ หัวอ่าน 
5. Insert Frame 
ตอบ การสร้างคีย์เฟรมใหม่ 
6. Frame Rate 
ตอบ ความเร็วในการแสดงภาพเคล่ือนไหว 
7. Copy Frame 
ตอบ การก๊อปป้ีเฟรม 
8. Keyframe 
ตอบ คีย์เฟรม 
9. Scens 
ตอบ ซีน 
10. ActionScript 



 

 

ตอบ เขียนค าส่ังในการแสดงภาพเคล่ือนไหว 
อธิบาย (หมายถึง การให้รายละเอียดเพิ่มเติม ขยายความ ถ้ามีตัวอย่างให้ยกตัวอย่าง  ประกอบ) ตอบ

แบบสั้น 
1. เลเยอร์มีส่วนประกอบอะไรบ้าง 
ตอบ   1. ช่ือเลเยอร์ 
 2.  โหมดควบคุมการใช้งานเลเยอร์ 
 3.  ปุ่มส าหรับเพิ่มเลเยอร์ 
 4.  ปุ่มส าหรับสร้างไกด์เลเยอร์ (Guide Layer) 
 5.  ปุ่มส าหรับสร้างโฟลเดอร์ 
2. อธิบายถึงวิธีการเพิ่มเลเยอร์ใหม่ว่าท าอย่างไรบ้าง 

ตอบ การเพิ่มเลเยอร์ใหม่ให้คลิกช่ือเลเยอร์ใดเลเยอร์หนึ่ง แล้วคลิกปุ่ม    Insert 
Layer 
3. อธิบายข้ันตอนการเปล่ียนช่ือเลเยอร์มาพอเข้าใจ 
ตอบ 1.  ดับเบ้ิลคลิกบนช่ือเลเยอร์ท่ีต้องการเปล่ียน 
 2.  ลบช่ือเลเยอร์เดิม แล้วป้อนช่ือใหม่ลงไปแทนในช่อง 
 3.  กด Enter 
 
4. การก าหนดคุณสมบัติของเลเยอร์สามารถท าได้อย่างไร 
ตอบ 1.  เปิดไฟล์งานท่ีต้องการขึ้นมา 
 2.  คลิกเมาส์ขวาท่ีเลเยอร์ เลือก Properties 
 3.  ในหน้าต่าง Properties สามารถปรับเปล่ียนคุณสมบัติตามต้องการ 
5. อธิบายข้ันตอนในการลบเลเยอร์มาพอเข้าใจ 
ตอบ ท าได้ 2 วิธี ดังนี้ 

 วิธีท่ี 1  เลือกเลเยอร์ท่ีต้องการ  แล้วคลิกลากไปปล่อยหรือคลิกไอคอน    
ด้านล่างของไทม์ไลน์ 
 วิธีท่ี 2  คลิกขวาบนเลเยอร์ท่ีต้องการ  แล้วคลิกค าส่ัง Delete Layer 
6. เลเยอร์ท้ังหมดท่ีมีอยู่มีลักษณะการเรียงล าดับกันอย่างไร 
ตอบ  ล าดับช้ันของเลเยอร์จะส่งผลต่อการซ้อนทับกันของออบเจ็กต์ท่ีปรากฏบนสเตจ  โดยออบเจ็กต์
ของเลเยอร์ด้านบนจะปรากฏอยู่เหนือออบเจ็กต์ของเลเยอร์ด้านล่างเสมอ 



 

 

7. เลเยอร์มาส์คคืออะไร 
ตอบ วิธีการสร้างเลเยอร์ท่ีเสมือนเป็นการเจาะช่องเอาไว้เพื่อให้สามารถมองทะลุไปยังเลเยอร์อื่นท่ีอยู่ใน
ล าดับถัดลงไป ซึ่งเราสามารถก าหนดลักษณะของช่องนี้ได้ตามปกติ และมักจะก าหนดให้มีการเคล่ือนไหว
เหมือนกับล่องหนไปบนเลเยอร์ในล าดับถัดไป 
8. เลเยอร์มาส์คสามารถน าไปประยุกต์ใช้งานกับงานใดได้บ้าง ยกตัวอย่างประกอบ 
ตอบ น าไปใช้กับงานแอนิเมช่ัน เช่น การท าตัวหนังสือให้คล้ายกับมีไฟสปอตไลท์ส่องอยู่ หรือการท า
คล่ืนในน้ าทะเล 
9. การเปล่ียนช่ือเลเยอร์ท่ีผู้ชมใช้กันมีกี่แบบ อะไรบ้าง อธิบาย 
ตอบ 2 วิธี 

1. ดับเบิลคลิกท่ีช่ือแล้วเปล่ียน 
2. คลิกขวาแล้วเลือก Rename 

10. การก าหนดทิศทางการเคล่ือนไหวด้วยไกล์เลเยอร์หมายถึงอะไร 
ตอบ การสร้างภาพเคล่ือนไหวต้องมีการก าหนดเส้นทางและทิศทางให้กับช้ินงานว่าจะให้ไปในทิศทาง
ใด ซึ่งเราสามารถท าได้ด้วยการใช้ไกด์เลเยอร์ เป็นการก าหนดเส้นทางหรือทิศทางให้กับการเคล่ือนไหวของ
ช้ินงานตามท่ีต้องการ 
 
ตอนที่  2  : อธิบายค าศัพท์ (หมายถึง การแปลค าศัพท์ ขยายความ อธิบายเพิ่มเติม ถ้ามีตัวอย่างให้

ยกตัวอย่างประกอบ) ตอบแบบสั้น 
1. Layer 
ตอบ เลเยอร์ คือ ส่วนหนึ่งของโปรแกรมท่ีมีความส าคัญกับการสร้างแอนิเมชันและควบคุมการ
เคล่ือนไหวในลักษณะต่างๆ ของ Symbol และช้ินงานในโปรแกรม Flash 8 (CS3) 
2. Layer Properties 
ตอบ ก าหนดคุณสมบัติของเลเยอร์ 
3. Layer Mark 
ตอบ เทคนิคการใช้เลเยอร์มาส์ค 
4. Guide Layer 
ตอบ ก าหนดทิศทางการเคล่ือนไหวด้วยไกด์เลเยอร์ 
  
 

 
 


